Read DV Full Motion, the only publication devoted entirely to users of Adobe’s Dynamic Media software.

DV Full Motion’s goal is to help you work smarter and more effectively. The newsletter focuses on high-end use of Premiere and After Effects, as well as new releases from Adobe’s Dynamic Media division. The newsletter also covers relevant third-party plug-ins and other products, such as Photoshop and Illustrator, as they relate to creative use of the core products.

Everything in the newsletter is geared specifically to helping you wring more out of your software—Mac or PC—and full-color images illustrate processes and effects. DV Full Motion’s authors are seasoned production experts, Adobe support specialists, and other industry leaders. They’ll go beyond the manuals to inspire and teach you.

Most articles describe creative techniques and innovative ideas that you can modify to your own needs. Others explore technical issues. Our Q & A column, “Smart Answers,” offers solutions to common difficulties, while our reviews of third-party software answer that important question: “Is it worth buying?” “The Full Account” column keeps you abreast of the latest news from Adobe and plug-in developers. You even get the chance to help your peers: The occasional readers’ tips section highlights useful tidbits offered by fellow readers.

See for yourself how helpful DV Full Motion can be. Read through the sample issue that follows. If you like it, give us a call. The charter rate for a one-year (six-issue) bimonthly subscription is $49.95 ($59.95 for Canadian and Mexican; $79.95 for other foreign airmail delivery). To order, call 603-472-2421, ext. 305, send a fax to 603-472-2419, e-mail llaflamme@dveast.mv.com, or mail your request to 120 Bedford Center Road, Suite 4, Bedford, NH 03110. Checks drawn on a US bank and credit cards accepted.
If initial reports hold up, Adobe has a winner on its hands with After Effects 3.0. “3.0 is a swing-for-the-fences rewrite that’s going to give SGI programs a run for their money,” says beta-tester Tim Sassoon, a visual effects supervisor at Dream Quest Images. Fellow tester Jeff Sargeant, principal of Sargeant Productions, agrees, “Adobe took the existing features that everybody loved and totally streamlined the interface so now they’re easier and faster to use. Plus, it added new features that before you could get only on advanced SGI systems.” After a tour of the new features and a look at the significantly lower $995 price, you may understand why the beta testers are so enthusiastic.

Close Ties
For starters, After Effects has been fully welcomed into the Adobe fold, providing deep support of Adobe Illustrator and Photoshop. When imported, Illustrator images remain in vector form until you render your comp, meaning you can manipulate them without losing any resolution. Says Sam DeWitt of Click 3x, “You can scale [an image] as big as you want, and it will never break up.” Working on a commercial for Nippon Telephone & Telegraph, Sassoon saw this first-hand when he zoomed an Illustrator map of Japan from 7% to 450,000% in one step with no quality loss.

Sam DeWitt of Click 3x created this frame from a Hershey’s commercial entirely within After Effects 3.0. Multiple mattes, keys and the Corner Pin plug-in contributed to building a night sky, moon (or is it a grin?) and reflection for video footage shot in the afternoon.

By Linda Laflamme
choose a transfer mode for each layer from a pop-up menu; the results appear on screen immediately.

**All at Once**

The new version’s support for multiple effects per layer and approach to composition flattening will change how you work, as well. Explains DeWitt, “Now you don’t have to do Compify. You can add, say, 14 effects to one layer without making a comp, bringing it into a new comp, then bringing that into a new comp.” With 3.0 you can apply an unlimited number of effects per layer, without composition nesting. Because effects filters are listed in the Effects Controls window as you select them, you later can change the order in which they’re processed by rearranging them in the list.

Masked Blackbird

With other path controls you can animate Bezier masks over time for complex traveling mask effects that even change shape. Sargeant used these to mask out actors Raul Julia, Laura Dem and Vanessa Redgrave for a commercial for the Showtime movie Down Came a Blackbird. “The effect we wanted was the actors kind of cut out from the background, but we didn’t want to shoot them on a blue screen. Instead we were able to separate them from their background with the Bezier mask tools. For the four-second scene we outlined them three times, and the program was able to interpolate and create a moving mask for them,” he explains.

Much less flashy, but equally helpful are After Effects’s interface and processing related upgrades. For example, all functions that can be interpolated—motion, property and effects filters—have interactive visual path controls. Real-time previews in 3.0 show a dotted line around the edge of the layer’s alpha channel instead of simply the layer’s bounding box. You’ll appreciate this feature when working with many layers, because you’ll be able to see some image content for each layer.

On the quality side, D1 pixel aspect-ratio support enables correct processing of source footage with non-square pixels, while 3:2 Pulldown Removal and Introduction compensates for frame rate differences between film and video. 3.0’s frame blending and deinterlacing work to keep quality high, as well. When you turn on the former and set a layer to Best quality, After Effects interpolates over a range of frames to generate intermediate frames for time-compressed and rendered to process all transformations and effects applied to compositions. For example, only when the parent comp is rendered are nested comps processed.

Thanks to the batch rendering option you can output multiple versions of these compositions simultaneously. Dave Tecson, president of Edgeworx finds this useful for efficiently outputting proof and final versions of his work, “In the past, we were forced to render one version to look at on a Motion-JPEG board, and then, after we’d determined that the project was done, we’d have to render it out all over again for uncompressed delivery on D1. The new output modules let us render both versions at the same time, so now when it’s done, it’s really done.” You can also save rendering settings you commonly use in template form for later projects and queue several jobs at once, changing their rendering order at any time via the Render Queue window.

**Unstuck in Time**

While it sounds like something out of a sci-fi movie, time and motion are separate in After Effects 3.0: You can edit the shape of an object’s motion path independently from the object’s timing along the path. To help you design more natural, fluid motion for your animations, new keyframe controls enable multiple keyframes to “rove” in time to maintain spatial integrity, while enabling velocity changes that span multiple keyframes. This lets you specify that an element smoothly accelerate or decelerate over any portion of a complex path. Spatial placement of keyframes is handled separately from their timing. Plus, you can interpolate changes in time and speed as you do other variables, meaning you can play a movie with such effects as variable slow motion, frame stuttering, backward playback and held frames.
-expanded sequences. With the program’s new approach to deinterlacing, it examines all of an imported video file’s frames, then deinterlaces only those areas that are moving. Overall, the upgrade seems faster, at least to Sassoon, who claims “when I had to go back to version 2.02, it felt like it was missing a gear compared to the 3.0 beta.”

**Less Than You’d Think**

A shiny new version deserves a shiny new price. When After Effects 3.0 ships this fall, Adobe will sell it through retail channels—a first for the program—for $995. This retail version includes a collection of more than 50 special effects. That’s right, more features for less money. For $1000 more at the outset, you can get a beefier configuration: The Production Bundle includes the new After Effects plus four sets of plug-ins for professional film and video producers. Adobe will automatically send the Production Bundle to registered users who bought After Effects 2.0 on or after July 8, 1995. Registered 2.0 users who purchased earlier may upgrade to the Production Bundle for $99, while registered 1.0 users may upgrade to the retail version of 3.0— that’s sans Production Bundle plug-ins— for $195.

Is the Production Bundle, available only from value-added resellers, worth the extra money? Sam DeWitt, Tim Sassoon and Jeff Sargeant think so. All agreed that, while some of its features aren’t fully implemented in their prerelease versions, it has the potential to make After Effects a blockbuster that rivals SGI software, most notably Discreet Logic’s Flame. (But don’t expect Flame-like speed, they are quick to caution.)

**Go with the Motion**

From Sassoon’s experience, motion tracking is one of the two most-used features of that $150,000 program. Motion Tracking and Image Stabilization are the two star attractions in the Production Bundle’s Motion Pack tool set. (That other Flame feature, by the way, is time remapping, which is included in even the retail version of 3.0) The Motion Tracking feature enables you to synchronize computer-generated elements to motion—even irregular bounces and shakes—in imported video, while Motion Stabilization digitally smooths and steadies such unwanted video hiccups.

According to DeWitt, “Because we have Motion Tracking and Stabilization, cameramen can do hand-held camera work, freeing the director to be infinitely more creative. No longer do we have to say the camera has to be locked off for us to be able to integrate graphics into their shot footage.”

Motion Tracking and Stabilization, as well as the Motion Pack’s other tools, belong to a group of controls called Keyframe Assistants that process groups of keyframes via algorithmic control. Rounding out the Assistants are Smoother, Wiggler, Easer, Motion Sketch and Motion Math. Smoother and Wiggler spawn wigglng and smoothing motions, while Easer creates ease-in and -out keyframes. Motion Sketch lets you design what-you-draw-is-what-you-get motion paths.

As you draw, Motion Sketch captures the path’s speed and movement; your object will accelerate and decelerate just where your cursor does. For the more technically minded, Motion Math lets you write custom motion-control equations that use layers and properties as variables.

The remainder of the Production Bundle is composed of the Keying, Distortion and Device Control Packs. The Keying Pack handles linear color keys, difference matting, spill suppression and matte choking. For special-effects razzle-dazzle, try the Distortion Pack’s Scatter, Ripple, Twirl, Glow, Bulge, Wave Warp, Corner Pin, Polar Coordinates and Displacement Map plug-ins. Finally, the Device Control Pack provides plug-ins for communicating directly with video post-production devices, such as Abekas and Accom digital disk recorders.

To run both the retail After Effects 3.0 and the After Effects 3.0 Production Bundle, you’ll need a Mac II or better with an FPU, System 7.0 or later, 6MB of application RAM (8MB for Power Macs) and 80MB of free hard-disk space. For best performance, however, Adobe (415/961-4400) recommends a Power Mac, System 7.5, at least 24MB of application RAM, two color monitors and a 500MB hard drive.

Sam DeWitt also suggests you set aside plenty of time to explore. “After Effects is a very professional tool. It’s one of those deep programs that you can use for years and keep finding new things.”
**Quick Change**

Speed up your Premiere transitions and filters with Truevision’s Targa 2000.

by Steve Mullen

Although Adobe Premiere 4.0 is one of the most feature-packed editing programs available, it can be frustrating to use. Often Premiere sessions seem to involve more waiting than editing. The biggest culprit is rendering effects. For example, a two-second page peel requires 225 seconds to render on a Power Mac 8100/80, meaning the render-duration to effect-duration ratio is 90:1. Likewise, rendering a three-second composite filter on an 8100/80 takes 240 seconds. The performance ratio, at 80:1, is equally poor. Because Premiere’s transitions and filters are not coded to use a floating-point processor, not even trading up to a super integer-crunching Power Mac 9500 will speed up matters. Installing Truevision’s Targa 2000 board will, however.

To understand why, you need to know how transitions and filters are processed. For example, to render a cross-dissolve on video clips, Premiere must first retrieve the compressed video data frame-by-frame from disk (via the SCSI bus controller), and then send it across the bus to the video compression/decompression board. Here the board’s JPEG chip decompresses the frames, and the vastly larger uncompressed data is sent across the bus into RAM. When two corresponding frames have been moved into RAM, the CPU calculates the transition. The resulting uncompressed frame, which is temporarily held in RAM, then goes back across the bus to the video compression/decompression board. The board recompresses the frame, and sends it across the bus to the SCSI controller; from there it is written to disk. This process is tremendously time consuming, regardless of the CPU’s speed.

**DVR is PDQ**

Available for Macs and PCs and bundled with Premiere 4.0, the Targa 2000 board ($5495 Mac and EISA PC; $5795 PCI PC) from Truevision (317/841-0332) delivers full-screen, NTSC or PAL, 60-field video recording and playback, plus two channels of 16-bit, 44kHz audio with hardware-based audio/video synchronization. More important to speed-conscious Premiere users, the board features Truevision’s DVR (digital video recorder) architecture: All digital video processing is organized around on-board RAM that all parts of the video processing architecture can access and share. With DVR, both compressed and uncompressed digital video are stored and manipulated in a single on-board memory space of 20 (shipped with the board) to 64 (the board’s max) megabytes.

In addition, DVR memory can be accessed at speeds reaching 234MB/sec. This allows the video-processing components to use this memory as a high-speed buffer when manipulating large data streams. Because DVR’s transfer rate far exceeds the practical data transfer capabilities of the NuBus and even the PCI bus, video data that remains on-board the Targa 2000 can be processed much faster than it can by the CPU.

DVR gives Premiere transitions a shortcut. Consider what happens when the cross dissolve is rewritten to take advantage of the Targa 2000: Premiere retrieves two frames of compressed video data from disk (via a SCSI bus controller) and sends them across the bus to the Targa 2000 board. The Targa 2000 JPEG codec then decompresses the two frames into its on-board DVR RAM. An AT&T DSP 3210 chip on the Targa 2000 computes the transition at very high speed. The resulting frame resides in DVR RAM. Next, this frame is recompressed from the DVR memory. In the final step, the frame is sent across the bus for storage on the hard disk (via the SCSI disk controller).

In this scenario, data crosses the bus just twice, and it crosses as compressed data only. Compared to the standard method’s multiple back-and-forth operations involving both compressed and uncompressed data, using the Targa 2000’s DVR on-board memory is far more efficient. For a two-second cross dissolve, the unaccelerated process sends 189MB over the bus, whereas the accelerated process sends only 27MB. This quickly translates to speed and productivity increases. In my Mac tests, Premiere’s unaccelerated, two-second cross dissolve took 121 seconds to render. When accelerated by the Targa 2000, the same transition rendered in 17 seconds! That result is even more impressive when you consider Data Translation’s highly regarded Media 100 renders its two-second Fast Dissolve in eight seconds—for twice the price of the Targa.

**When accelerated by the Targa 2000 board, Premiere transitions that normally render in about two minutes render in as little as 17 seconds.**

**The Speedy Seven**

Before an effect can be turbocharged by the Targa, however, it must be reprogrammed for the board’s DSP (digital signal processing) chip. Of the more than 70 transitions Premiere offers, Truevision estimates most people use a core set of seven—cross dissolve, wipe, push, slide, barn doors, stretch and zoom—90 percent of the time. At this writing, only cross dissolve and wipe are accelerated on the Mac, with the remaining five soon to follow. All seven are included with the PC version. They all require the same processing time on the Targa 2000.

To use the accelerated transitions, you must be running Premiere 4.0.1 (Mac) or 4.0a (Windows). Install the Targa 2000 hardware and software, and then pop a copy Truevision’s F/X library into Premiere’s Plug-ins folder. The effects automatically appear in Premiere’s Transition window. Using them is the same as using ordinary Premiere transitions, only faster.
From Premiere to CD-ROM

Add these principles to your production repertoire for successful video delivery on CD.

By Jan Ozer

Want to deliver your Premiere masterpiece on CD-ROM? You’ll need to know a few things. They’re simple things, and it pays to get them right the first time because they affect your results quite dramatically.

You’re hit with choices relating to CD-ROM production right when you load Premiere 4.0: The first screen to appear is the Presets screen, which defines project-output options (see the box “Premiere CD-ROM Mastering Presets,” below). But before you begin creating video—even using the presets—you need a strong fundamental knowledge of the unique challenges of CD-ROM. That’s what this article is all about.

So let’s look first at the basics, which center on bandwidth issues. Then we’ll move on to the larger topics of presets, architecture and codec. While I write from the vantage point of Premiere for Windows, you’ll find that the fundamentals apply to Mac as well.

The Implications of Bandwidth

Video compression parameters must be set early in the design process to lock down screen size and placement. Before you can select these options, however, you must identify your target customers and the configuration of their computers.

Each CD-ROM drive has certain capacity for retrieving data, and no amount of huffing and puffing can change it. Single-spin (1X) drives retrieve at 150K per second, double-spin (2X) drives at 300K/sec and so on.

When you compress a file for playback, you select the target data rate—the amount of video and audio data per second: With a data rate of 300K/sec, each second of video has, logically, 300K of data. If the bandwidth requirement of your video exceeds the capacity of your target CD-ROM drive, your video will start and stop like a jalopy on a cold morning.

So the first critical decision facing CD-ROM developers is target capacity. Because video quality relates directly to data rate, video designed for single-speed systems are jerky, postage-stamp size displays. Since early 1994, though, most multimedia computers have shipped with 2X drives, so developers started shipping titles with video bandwidths of 160–225K per second. This ruled out the installed base of single-spin drives, but maximized video quality for owners of the new computers, including 486 or Pentium local-bus systems.

Audio bandwidth contributes to the total, but is set separately by configuring the audio parameters in the Project Output Options dialog box. CD-ROM-quality audio requires 176K/sec of bandwidth, leaving little room for video. And given the tinny quality of most computer speakers, it is often wasted. So most producers use relatively low-quality audio. Premiere’s presets use 8-bit/11kHz mono, for a total of 11K/sec—just right for a 100K/sec rate. For double-speed CD-ROMs, you can increase the quality—to 8-bit/22kHz mono or 16-bit/11kHz mono, for instance—but most producers never exceed 22K/sec.

Test Early!

Retrieval data from a CD-ROM takes more CPU cycles than it does from a hard drive, leaving fewer to devote to decompression and display. On low-end machines, this means your video will play slower from CD-ROM than from the hard drive.

How much slower depends on the computer, but mostly on the CD-ROM drive; drives vary greatly in efficiency. This makes it critical to test your video from a CD-ROM early on (especially before you show your boss or client, and preferably on a target-platform computer) and to factor the test results into your video configuration.

On my trusty 486/66, I can play 320 × 240 video at 30fps from my hard drive. From a CD-ROM, I’m lucky to get 8 or 9fps if I compress the video at 30fps. If I compress at 15fps, however, it plays fine from the CD-ROM, even on 486/33 ISA computers. This is why most CD-ROM developers work with 15fps video, and why all of Premiere’s presets use 15fps.

However, while Premiere assumed a video resolution of 240 × 180 in all presets, the most common resolution used today is 320 × 240—once again, for the newer computers. As with the target data-rate selection, the decision is up to you.

The most useful product for testing CD-ROM performance is VidTest, from Microsoft, because it allows you to measure both the efficiency of your CD-ROM and how fast the video plays back on your target computer. VidTest is available only on Microsoft’s Jumpstart disk, a CD-ROM distributed free of charge to multimedia developers. To receive the disk, fax your request to 206/936-7329.

VFW or QTW?

Premiere 4.0 can output files for two general programming architectures: Video for Windows (VFW) and QuickTime for Win-

The Presets Screen

Premiere for Windows’s opening screen offers four CD-ROM mastering options:

- CD-ROM Mastering: Cinepak
- CD-ROM Mastering: Cinepak/QT
- CD-ROM Mastering: Indeo
- CD-ROM Mastering: Indeo/QT

These options simplify the process of creating video on CD-ROM, especially those targeting mass market distribution. For the most part, however, the parameters corresponding to these presets are conservative in both data rate (100K/sec) and video resolution. Depending on your target market, you can be more aggressive: just change the data rate in the Compression Options screen before making your movie. The result will be bigger, better-looking video.
Indeo has a slight edge in quality, but Cinepak usually plays faster.

Codec Choices
Premiere’s two codec presets, Cinepak (by Radius) and Indeo (by Intel), are available in both QTW and VWF formats. You can access another codec, Video 1 for both QTW and VWF, by changing the compression options before building the movie.

In terms of quality, Indeo has a slight edge, especially in videos with little motion, such as “talking-head” sequences. On the other hand, Cinepak usually plays back faster than Indeo, so Cinepak may be better if you’re targeting lower-end computers. (Incidentally, both Radius and Intel plan major upgrades for their respective codecs around September, so watch for announcements.)

Video 1 should be considered only for videos with very subtle motion. Unlike Cinepak and Indeo, Video 1 is an 8-bit codec. While this makes it somewhat easier to use in products bound for 8-bit display, even moderate motion causes Video 1 to become extremely pixelated, so it is inappropriate for general purpose use.

While we’re on the topic, let’s see how video fits into the 8-bit environment.

Palette Considerations
Although most developers use 24-bit graphics cards, most of the installed base uses 8-bit displays. These displays are limited to 256 colors, called a palette because all screen elements must be painted with colors contained in it. The 256-color combination is not fixed—palettes can and do change. At any one point, however, only 256 colors can be used to describe all screen objects.

When a new graphic object is displayed, Windows checks to be sure that the colors in its palette are available. If they are not, Windows changes to the new object’s palette, momentarily freezing the screen, usually in a bizarre, psychedelic display. Called palette flashing, this is the developer’s equivalent of “ring around the collar.”

Most developers create an “optimal” palette designed to complement the graphic objects displayed in the title. How does this work with video?

Codecs break into two categories. Eight-bit codecs such as Video 1 can compress and decompress to an assigned palette, so you can use the optimal palette and treat the video as any other graphic object. In Premiere, you assign a palette in the Compression Options screen prior to compression.

This won’t work, however, with 24-bit codecs like Cinepak and Indeo that always decompress to their own unique palettes. You can avoid palette flashing four ways:

• Black the screen between pages, allowing the palette to reset without flashing. This may not work if your main screen uses more than the 20 colors reserved in the palette for Windows, and end-users may find the delay unacceptable.

• Force the videos (through your authoring program or MCI commands) to adopt the optimal palette during display. Video for Windows 1.1d introduced the Active Palette, which intelligently reorders the palette to optimize video appearance. But forcing Indeo and Cinepak to use a different palette makes decompression less efficient, which can slow the display significantly, especially on older computers.

• Use the codec’s palette as the optimal palette for the entire presentation. Both palettes were developed to service a range of videos and contain a wide selection of colors. The easiest way to obtain the palettes is via CompuServe: In the Microsoft Windows Multimedia forum (go Winmm), search the digital video library for Ron Wodaski’s January, 1994 file entitled VB Application And Text for Video Palettes.

• Use only the 20 colors in the standard Windows Palette as your background (but this is boring).

The Seven Essentials
Let me leave you with a checklist of things to consider when preparing to deliver on CD-ROM:

1. When filming, remember that these files will be compressed significantly to play from a CD-ROM. The most powerful form of compression, interframe compression, works by removing static data between frames. Thus, a talking-head video, with its slight motion, will compress better than a roller-coaster sequence.

2. Minimize such extraneous motion as slow pans, zooms or hand-held camera jitter. This will optimize the essential motion.

3. Capture video at the highest possible data rate to optimize precompression quality. Don’t attempt to capture at the target data rate (but do capture audio at the target configuration).

4. Remember that some transitions look like motion to the codec, and thus can reduce video quality. The most “compression friendly” transitions involve two stable videos with a moving transition that hides one while revealing the other (a wipe or clock transition, for example). “Unfriendly” transitions move both videos simultaneously (a push) or change every pixel every frame (dissolve or fade).

5. For compressing, select a target data rate reasonably below your target CD-ROM drive. For a single-spin CD-ROM use about 130K/sec, for double-spin use no more than 250K/sec.

6. Make sure your audio parameters are correct before compressing, especially if you’ve inserted high-bandwidth audio clips. Otherwise, Premiere must compress the video more to provide the requested data rate.

7. Run the Movie Analyzer before calling it a wrap.
By Trish Meyer

You've got this digital video thing down—your movies even play from your new disk array without dropped frames. So, why isn't the motion as smooth as glass? And why do your movies develop undesirable artifacts when you scale them? You could be missing some field rendering techniques that effectively double your frame rate and increase quality at the same time. The examples below use Adobe After Effects 2.02, but the lessons you'll learn apply to other digital video programs, as well.

Frames versus Fields

When creating movies for NTSC, you should understand how a TV screen's image is drawn. Unlike a computer, which draws pixels from left to right and then progressively from the top to the bottom of a monitor in one pass, NTSC video draws each frame of video in two passes, called fields. It draws every other scan line on its way down, and when it's done, it returns to the top 1/60th of a second later and fills in the missing lines to complete one interlaced frame (in 1/30th of a second).

A system that draws the odd lines before the even lines is said to be Upper, or Odd, Field First; one that draws the even lines before the odd lines is said to be Lower, or Even, Field First. While Upper Field First is more common, some systems are Lower Field—notably, Abekas disk recorders when fed with Exabyte tapes. Some systems (Diaquest and MacVac) have the ability to swap field order as you output your animations frame by frame.

Where Do Fields Come From?

When you shoot footage with your camcorder, it does not record whole frames to tape. It captures one field, and then a second field, laying them down in a linear fashion to the tape at a rate of 60 fields per second. When you play the tape to an NTSC monitor from an Upper Field First system, the first field comes off the tape filling the odd lines on the monitor, then the second field fills the even lines. When you set Radius's VideoVision Studio, for example, to capture 640 x 480 video, you're capturing all 60 fields as they go by. (A video card capable of capturing only 320 x 240 grabs only every other field.)

Who's First?

Because fields are captured to tape 1/60th of a second apart, each field's data belongs to a certain time. Just as you wouldn't play frame 2 before frame 1, likewise you won't want to reverse fields and play the second one before the first. If you do, fast moving objects will shudder. Before you do a final render in After Effects, run a short test to determine your playback system's field order:

- Animate some fast moving still objects at the system's optimum resolution (i.e. 640 x 480 or 720 x 486).
- In the Make Movie dialog, render once at 30fps (or 29.97), and from the Field Render popup, select Upper Field First (Figure 1).
- Render the comp again as Lower Field First.
- Play both movies through your system; one version will look noticeably smoother. (If you can't see a difference, the motion isn't fast enough or your system isn't capable of playing fields.)

Field Rendering an Animation

To field render an animation, simply select the correct field dominance in the Make Movie dialog. After Effects does the rest! Notice that After Effects makes two renders passes for each frame, before it compresses and writes an interlaced frame to disk. For example, if you render a 30fps/Upper Field First movie:

- After Effects starts at 00:00U (the U stands for Upper Field) and figures out what all the layers would look like at this starting point (their position, scale, opacity, ripple effect, etc.). It then sets aside this frame in RAM.
- Next it advances the Comp 1/60th of a second (a position between 00:00 and 00:01), and renders frame 00:00L (or Lower Field). Here it again figures out what all the animated layers would look like, and stores this frame in RAM.
- Because you specified Field Render>Upper Field First, After Effects keeps all the odd lines from 00:00U (for the Upper Field), and all the even lines from 00:00L (for the Lower Field), and interlaces them to make a full frame, which is saved to disk as frame 00:00. (Figure 2)
- The resulting interlaced movie is Upper Field First, because the Upper Field belongs to an earlier point in time than the Lower Field and because it plays properly on an Upper Field First system only.

The Deinterlace Option Discovered

Say you capture some great footage at full-frame, 60 fields, scale the footage to 75%, composite it over a still image to frame it and render the Comp at 30fps, no fields. When you play the movie on an NTSC monitor, however, it jitters oddly. You try field rendering Upper Field First, then Lower Field First with no luck. What are you missing?

Because After Effects wasn't told it had an inter-
laced movie, it treated the video as if it was noninterlaced (or full-frame, like a still image). In other words, it considered the whole first frame as belonging to the same point in time and thought it was therefore appropriate to mix the pixels from both fields when scaling to 75%. Even if you field render on output, a mixture of two fields from the source movie ends up on both fields in the output movie. If you’ve time-stretched the clip, the results will be even worse.

To avoid this, every time you import a movie captured at 60 fields, immediately select the footage in the Project list and choose Deinterlace in the Interpret Footage dialog (Figure 3). This tells After Effects to construct a full frame out of each field, using field interpolation at Best quality or field doubling at Draft quality. Now when you field render your project, interlaced source footage will be processed correctly: Only pixels derived from the upper fields of the source movie end up in the upper fields of the output movie, while pixels derived from the lower fields of the source are routed to the lower fields on output.

The trick is that you must know whether the clip is Upper Field First or Lower Field First when you deinterlace. If you’re not sure, guess Upper Field First. As a test, open and play the clip directly from the footage window. This plays each field (interpolated to a full frame), and if the guess was correct, moving objects in the clip will make steady progress. If you guessed wrong, the object will stagger back and forth.

### Deinterlacing Rules

Stills can have motion problems, as well. When you grab a frame off tape or export a frame from an interlaced QuickTime movie, moving objects may look strange because they changed position while the camera was recording both fields. If you plan to use the frame grab as a still, run the Video>De-interlace filter in Photoshop, which throws away one of the fields and replaces the now-missing pixels with an interpolation of the other field. If you don’t deinterlace and there is prominent “motion” in the frame grab, the image will flicker on an NTSC monitor.

If you need to hold on the first or last frame of an interlaced clip, be careful which field you discard with the De-interlace filter. For a hold on the start frame, keep the first field, so that when the clip starts there’s no backing up. Holding on the last frame is trickier: If you’ve already played the last frame, then hold on the second field to avoid backing up. If you’re using the hold frame in place of the last frame, then hold on the first field so that you don’t skip over it.

### Video Footage intended for playback on an RGB (progressive scan) computer monitor must be deinterlaced, as well. To deinterlace an entire clip in After Effects:

- Select the clip in the Project list, and specify Interpre Footage>Deinterlace.
- In the Make Movie dialog, render with Field Render>Off. This takes only the first field from each frame of the source movie, and sends them to each frame of the output movie. The result is that you effectively deinterlace the movie, keeping the correct field.

Most 3D programs are unable to field render an animation, but you can get the same effect by rendering the 3D animation at 60 frames per second. (Caveat: Unless your animation’s objects are moving quite quickly, it may not be worth doubling your 3D rendering time!) When you import this 60fps movie or PICT sequence, and then field render it at 30fps, After Effects will retrieve two animation frames per video frame and interlace them.

Incidentally, importing a 30fps animation and processing it through After Effects with field rendering turned on does not give you an “interlaced” movie. If After Effects does not have the necessary data to work with (a 60fps movie, that is), the result will be just the same as the source.

### The Payoff

If you’re the creative artist type, you may think that all this technical stuff should be someone else’s concern. Maybe so, but try telling that to the client who’s wondering why their video has a severe case of the jitters! Learning how to field render and handle 60-field footage correctly will pay off in smoother, more professional-looking videos.

### Tips for the Battle Field

- If you need to reverse the field order of an interlaced QuickTime movie:
  1. Import the movie into After Effects.
  2. Don’t interpret the footage.
  3. Place it in a Comp that’s the same size.
  4. Move it down one pixel.
  5. Render again as 30fps, with no field rendering.

  This moves each field down one scan line, so the odd field becomes even, and the even field becomes odd. The drawback is that you lose one line off the top and bottom, but on an over-scanned NTSC screen, this is not a problem.

- Because field rendering requires a full-size frame (640 × 480 or 640 × 240), you should not field render movies that are less than full frame. Even if you use hardware zoom to make a 320 × 240 fill the screen on playback, each “field” would be zoomed up to occupy two scan lines.

- Unless your source footage is interlaced, don’t deinterlace it with the Interpret Footage option. That goes for photos, text and movies that are less than 640 × 480.
By Nels Johnson

Want to create video for Internet distribution? Then forget most of what you know. The working and practicing you did for capturing and compressing good-looking 320 × 240, 15 frames-per-second clips are mostly useless in this realm. Suddenly, smaller movie windows and fewer frames per second are better. That’s right, 160 × 120, 10fps clips are back in vogue!

The reason for this unsettling reversal is that, for Internet movies, file size is critical. Most World Wide Web explorers do not want to risk downloading more than a megabyte or two of video when they don’t know what they’ll be getting.

On the other hand, the longer the good material, the better. The best clips you will find online these days are, in effect, trailers—or even one-liners. To get the most out of them, producers should keep movie rectangles small, frame rates to a minimum and audio tracks low-fidelity (thereby increasing playback time while staying within size limits).

Of course, the above arguments assume that Internet-downloaded QuickTime, AVI and (to some extent) MPEG files are basically informational, as opposed to full-on entertaining. This doesn’t mean that such clips are inherently boring, just that we should subject them to new aesthetic criteria—at least until modem speeds available to the average consumer improve.

New Challenges— and Rewards
Judging by the log files net administrators keep (and according to press hype), people are swarming over Web and FTP sites for all the movies they can find. Unfortunately, a lot of what they are downloading was not made with Internet distribution in mind. Why not exceed (and thus raise) their expectations?

Creating a well-made video file for the Web is challenging and satisfying, both technically and creatively. With Premiere—especially the Windows 4.0 version—you have a complete tool chest for making your clips Internet-ready and for mixing entertainment with your informational content. I’ll start by discussing key Premiere features that can help this endeavor. Then, I’ll present a step-by-step production example, and point you to an online movie made according to the principles we are advocating.

The Rights Tools for the Job
Four of Premiere’s features are key to generating ready-for-Web digital video. They are:

• Top-of-the-line editing power
  As a desktop video editing program, Premiere has already proven itself to be world class. It had better be. Effectively cutting a large body of raw footage into a 20 or 30 second stinger is a task even the most seasoned editor finds formidable. The power to both inform and entertain your audience in such a short time lies in your mastery of effects and transitions, both of which Premiere supplies in abundance. Anyone who has made a commercial knows what this is all about.

• Both AVI and QuickTime output
  Premiere 4.0 for Windows can output clips encoded as either AVI (Video for Windows) or QTW (flattened QuickTime, playable on both Macintosh and Windows machines) from the same project. This is a very useful feature, since state-of-the-art web and FTP sites generally offer both formats. Depending on the platform used for capture, some gamma correction (a stock filter for this is included with Premiere) may be needed.

• Sophisticated titling features
  Internet video clips need good titles for at least two reasons: copyright protection and maintaining the philosophy that communication of information is key. Under Premiere’s File/New menu is a Title item that brings up a powerful title editing tool. If you have ever used Windows Paintbrush to render title frames for appending with VidEdit, you will appreciate Premiere’s solution. Automatic centering, drop shadows and the ability to superimpose text on existing movie frames are all included (superimposition of text is clearly an excellent way to keep your clips compact).

• Audio processing tools
  Speaking of VidEdit, you may have noticed its audio handling limitations. While you can change a soundtrack’s sampling rate, bit depth and stereo mono attribute, you cannot adjust the volume or add effects (of course, you can always export the audio...
track as a WAV file, bring it into a program such as Sound Forge for surgery, then reunite it with the video track using VidEdit). With Premiere, you can do everything that VidEdit can to reduce the audio data rate, as well as modulate the volume and add limited effects (such as echo). Perhaps most importantly, you can mix multiple sound tracks—an excellent way to add information.

A Production Example

What’s the best size, in bytes, for a generic downloadable World Wide Web movie? Assuming that different types of content do not by nature imply different relative file sizes, a good rule of thumb seems to be what will fit on a standard high-density floppy disk: approximately 1.44 megabytes. Accounting for such unpredictable factors as network traffic, such a clip will take around 10–15 minutes to download. With the following attributes, this clip will deliver between 25 and 30 seconds of playback time under either Video for Windows or QuickTime (both Mac and Windows):

- File size: approximately 1.4MB
- Data rate: 50K (Note: Check the math: 50K for 25 seconds = 1.25MB)
- Movie window size: 160 x 120 pixels
- Frame rate: 10fps
- Compressor: Cinepak
- Audio: 8-bit, 11.025kHz/monaural

As it turns out, this clip actually exists—on my company’s Web site. Surf to www.sf-canyon.com and download the file FMSAMPLE.AVI to see if all the information presented so far checks out. (From the sf-canyon home page, select Utilities to Download, look for FMSAMPLE.AVI, and follow the accompanying instructions.) I’ll show you now how my group produced that clip using Premiere 4.0 for Windows.

How We Did It

The analog source for FMSAMPLE.AVI was a Hi8 videotape shot with a Sony TR-81 camcorder. The capture hardware included a Sony EVO 9800A Hi8 deck and the Intel Smart Video Recorder Pro plugged into a 486-DX2 66 PC. I used Premiere’s capture facility to digitize several minutes worth of footage in several dozen Indeo Raw-format files, at 240 x 180, 10fps. Each of the raw clips was imported into our working project.

Using Premiere’s cropping tool, we stripped each raw clip of its edges and as much uninteresting background as possible, so that only the most dramatic visual information was retained for the 160 x 120 movie window. The cropped clips were output by Premiere still as Indeo Raw. (For the record, these first two steps—capture and cropping—can be accomplished just as easily with VidCap and VidEdit. But neither of these programs can hold a candle to Premiere as a one-stop shopping solution.)

For the sake of having a plan, we gave a duration of one second to each raw clip we placed into the A and B timeline in Premiere’s Construction window. This ensured abundant cuts and other transitions—the currency of information-rich video. Further, each clip overlapped its successor and predecessor (in the complementary timeline) by half a second. The default transition effect was the stock cross fade, until experimentation suggested otherwise—which it ultimately did. Just as a reality check, we periodically generated the whole movie using Cinepak. So far, so good.

Use Those FX!

We wanted some music mixed in with the movie’s natural sound track, so we used Premiere’s audio-capture utility to digitize an instrumental in WAV format. Then we imported this clip into our project as well, and placed it in the next open audio track. During the experimentation phase we mixed the audio tracks radically, hoping to find the perfect combination of volume, proportion and echo (all at the bare minimum of 8-bit, 11.025kHz mono).

What they used to say about fonts for desktop publishing applies equally to video-transition effects: Having access to hundreds of them gives you the power to turn out really spooky results. In traditional film and video, a transition usually reflects the mood of the unfolding narrative. MTV, however, has taught us that radical editing and FX strategies can impart layers of meaning just as decisively as otherwise ordinary production techniques.

Thanks to the random access of digital editing software, you can test this thesis and not get bored in the process (assuming you have a relatively fast computer). We applied most of Premiere’s transitions to the half-second overlaps in the two timelines and then kept testing them until things felt right. Ultimately, we used as many fades and cuts as special effects, but at least the doubt factor as to what would work best was removed.

Premiere’s Title editor helped us to complete the job. FMSAMPLE.AVI is bookended with title and credits frames, and other titles are superimposed throughout. Tradition dictates that titling is done last, but you should feel comfortable using it throughout the production process. Make titles with unexpected shadow colors, or that are big enough to bleed off the page. Text information that contradicts visual information can send all kinds of interesting messages.

The Great Mediator

It’s an interesting time for multimedia. The CD-ROM market, primarily a consumer of entertainment, wants television quality but is constrained by today’s bandwidth and media-storage limitations. The Internet market wants both information and entertainment while facing even more severe constraints. The difference between sides is creating divergent standards for desktop video production. Fortunately, Premiere can handle the load in either case.
Premiere Plug-ins Resource

You can never have too many effects and tools. These add-ons give Premiere that something extra.

Need to stretch Premiere’s feature set a little further? Check out the list of plug-ins below. Third-party developers have been busy, so you may find just the effect or tool you want. Plug-ins marked with a ★ are available directly from the developer or from the Adobe Plug-in Source (800/685-3547, fax: 206/489-3446).

★ **CyberSound FX**
$129, Mac

INVISION INTERACTIVE
2445 Faber Place, Suite 102
Palo Alto, CA 94303-3316
415/812-7380 • 415/812-7386 fax

CyberSound FX, an audio-effects processor, offers more than 150 preset templates arranged in 17 FX Groups, including Equalization, Echo, Reverberation and Tremelo. Not simply add-in sound effects, the templates process your existing Premiere audio. With CyberSound, you can make your narrator sound as though she’s speaking from a concert hall, a large bathroom, a jazz club, under water or a large bathroom. Via its software and control panels, you can fully animate, and you can adjust the smoothness of all effect patterns.

★ **Dynamic Effects**
$119, Mac

GRYPHON SOFTWARE CORP.
7220 Trade Street, Suite 120
San Diego, CA 92121
619/536-8815 • 619/536-8932 fax

A set of 20 plug-ins, Dynamic Effects lets you build animated special effects for your QuickTime movies. Filters include Channel Delay, Duotone, Dust, Dynamic ZigZag, Luminance Jitter, Mirror, Soft Focus, Dynamic Twirl and Roll Tiles. In addition, Dynamic Effects comes with two transitions: Smooth Wipe and Smooth Iris.

★ **The Gradient Experience**
$139, Mac and Windows

CINETIC GMBH
Karlstrasse 2
D-76227 Karlsruhe
ermy
011-49-721-94329-0
011-49-721-94329-22 fax

The Gradient Experience provides 200 digital-video effects for Premiere. It also enables you to import any PICT file into Premiere as an effect pattern. With the package’s Gradient Explorer, you can preview and modify your patterns. All previews are fully animated, and you can adjust the smoothness of all effect patterns.

★ **ProVtr**
$99, Mac

PIPER DIGITAL
45-508 LoLii St.
Kaneohe, HI 96744
800/798-8793 • 808/247-3320 fax

ProVtr is also available bundled with Pipeline’s AutoLog software for $249.

★ **Q2 ParaGraphic EQ**
Call for price, Mac

WAVES
4028 Papermill Rd, Suite 14
Knoxville, TN 37909
615/588-9307

The Q2 ParaGraphic EQ offers two bands of full parametric filtering. Each band can be a Bell, High/Low Shelf or High/Low Pass filter. EQ controls let you set each of the two bands to frequencies from 16 to 20kHz. The Q is adjustable from 0.5 to 100.0. Gain range is +/-18dB. The Q2 also has low-noise filters.

★ **Q10 ParaGraphic EQ**
$450, Mac

WAVES
615/588-9307 • 615/588-9432

The Q10 provides ten bands of stereo equalization and five types of filters. A library of more than 200 setups—PseudoStereo, Brickwall Bandlimiting, Psychoacoustic Noise Filters, Radio and Pre/De-emphasis, among others—helps you get started. The Q10 uses Wave’s IDR technology for dithering and noise shaping to minimize distortion.

★ **Soundstream Audio Filters**
$129, Mac

CARILLON MEDIA CORP.
PO Box 1446
Los Alamitos, CA 90720
800/487-8501

The Soundstream Audio Filters library is an integrated set of audio production plug-ins. Among the filters are Pitch Shift, Reverberation, Digital Delay, Noise Generator, Flange and Robot Voices, Chorus, Ring Modulator, and Low/High Pass and Notch Filters. There’s also a seven-band graphic equalizer and a waveform generator.

★ **Ultimate for Macintosh**
$1495, Mac

ULTIMATE CORP.
20554 Plummer St
Chatsworth, CA 91311
818/993-8007 • 818/993-3762 fax

Ultimate for Macintosh provides automatic masking for blue- and green-screen compositing. The Ultimate Intelligence and Color Correction features combine to automatically match colors in the foreground and background images. Zoom, pan, wipe and undo tools assist in further fine-tuning your composites.

★ **VTK Plug In Pack**
$99, Mac

ABBATE VIDEO INC.
14 Ross Ave., Floor 3
Millis, MA 02054-1545
508/376-3712 • 508/376-3714 fax

The VTK Plug In Pack adds to Premiere device control for a range of consumer and professional video decks and camcorders. Via its software and control cables, it locates specified scenes and signals Premiere when to start and stop digitizing. If timecode is available, VTK Plug In Pack can read and attach it.

★ **WaveConvert**
$299, Mac

WAVES

An audio-conversion tool, WaveConvert converts between sampling rates, as well as 16-bit and 8-bit depths. You can set the audio-level maximization, brightness and noise-gate type, as well as control the speed/quality tradeoff. Automatic gain control enhancements are also provided.
That’s Final (Effects)!

Take this new After Effects plug-in package for a spin around the world and through a snowstorm.

by Tim Sassoon

If you’re after more effects for After Effects, consider Final Effects from UDAC Multimedia of Uppsala, Sweden. Adding remarkable new capabilities to After Effects, the Final Effects plug-ins package is comprised of 32 effects grouped into ten categories: Distort, Image Control, Iteration, Light, Time, Niche, Particle, Perspective, Stylize and Transition.

The categories are packed. Under Distort you’ll find such effects as Flo Motion (which warps the frame around bipolar attractors) and Lens (an instant magnifying-glass distortion), as well as Griddler, Slant, Slant Matte and Tiler. Image Control includes the very useful Color Offset, which gives you a hue phase wheel for each color channel; Level View, which is the same as After Effects’s standard Levels but with a per-channel histogram overlay; Threshold and Threshold RGB. Iteration has Splatter and Video Reverb, while Light has Light Burst, a good place to start when making explosions. Time has Motion Trail, a great old video effect, and Time Map, which creates a composite blend from adjacent frames.

Niche’s Cartoon Sequencer is an answer to a problem faced by character animators: what to do about frames that need to repeat in the middle of a sequence. Now cel animators won’t have to create duplicates or additional layers when working in After Effects.

Stylize includes Kaleida, perfect for your next Fruitopia ad, as well as the excellent Page Turn. Page Turn enables you to render only the front, back or under layer; you can have different video in each layer by applying the effect over three layers simultaneously. Plus, you get a highlight on the fold. Also in the set is Scatterize, similar to After Effects’s Scatter but with a pseudo-3D warp, and Splatter Paint, which does just that.

Need wipes? Look under Transition, where you’ll find Image Wipe, which operates based on the luminance of the layer of your choice; Radial Scale Wipe, a distorting sci-fi version of an iris wipe; and Scale Wipe, which streaks the image off the screen.

These sets of effects alone would make a good package, but the real stars of the Final Effects show are the particle effects. Yes, particles. With Final Effect’s particles you can easily animate sparks, explosions, smoke, snow and rain, as well as build unique effects. For example, Ball Action breaks an image down into little 3D balls that you can explode in various interesting ways. Because After Effects is a 2D animation program you can’t build as complex a particle stream as you can in a true 3D program, but I’ve found that Final Effects’s particles cover most situations handily. Their convenience, speed and ease of use can’t be beat; I’m sure they paid back the entire package price ($480) the first time I used them for a job.

Set the World Spinning

Working with Final Effects is easy, too. To give you an idea, I’ll walk you through building a rotating Earth with some type spinning around it. Besides Final Effects, you’ll need Adobe After Effects 2.02 and Adobe Photoshop 3.0. As with cooking, there are a hundred ways to do this, but if you follow me your results will match the illustrations. My apologies to those of you who don’t need exact step-by-step instructions.

First, fire up Photoshop, and open your Scrapbook from the Apple menu. Copy (Command-C) the Earth map picture (Figure 1), and closing the Scrapbook, return to Photoshop. From the File menu, choose New, name the file World.pict and click Okay. Paste (Command-V) the Earth map into your new document, and save it as a PICT file (Figure 2).

Quit Photoshop, and launch After Effects—with Final Effects or the Final Effects demo folder (see the sidebar “Try It Yourself,” next page) in the After Effects folder. Create a new composition called Type Comp. The size should be 512 × 256 pixels, but the length doesn’t matter; I used 100 frames (03:10). Make a new Solid (under the Layer menu), also 512 × 256. Click on the eyedropper tool in the New Solid dialog, and click in the surrounding white area.

Choose Text>Basic Text from the Effect menu. In the Text dialog, type the phrase that will orbit the Earth. Set the text to Centered, and click OK. If you can’t see the Effect floater, try Floaters>Effect Controls under the Window menu. In the Effect Controls floater, check Invert Text and click in the surrounding white area.

Type the phrase that will orbit the Earth. Set the text to Centered, and click OK. If you can’t see the Effect floater, try Floaters>Effect Controls under the Window menu. In the Effect Controls floater, check Invert Text and click in the surrounding white area.

That’s Final (Effects)!

Take this new After Effects plug-in package for a spin around the world and through a snowstorm.

by Tim Sassoon

If you’re after more effects for After Effects, consider Final Effects from UDAC Multimedia of Uppsala, Sweden. Adding remarkable new capabilities to After Effects, the Final Effects plug-ins package is comprised of 32 effects grouped into ten categories: Distort, Image Control, Iteration, Light, Time, Niche, Particle, Perspective, Stylize and Transition.

The categories are packed. Under Distort you’ll find such effects as Flo Motion (which warps the frame around bipolar attractors) and Lens (an instant magnifying-glass distortion), as well as Griddler, Slant, Slant Matte and Tiler. Image Control includes the very useful Color Offset, which gives you a hue phase wheel for each color channel; Level View, which is the same as After Effects’s standard Levels but with a per-channel histogram overlay; Threshold and Threshold RGB. Iteration has Splatter and Video Reverb, while Light has Light Burst, a good place to start when making explosions. Time has Motion Trail, a great old video effect, and Time Map, which creates a composite blend from adjacent frames.

Niche’s Cartoon Sequencer is an answer to a problem faced by character animators: what to do about frames that need to repeat in the middle of a sequence. Now cel animators won’t have to create duplicates or additional layers when working in After Effects.

Stylize includes Kaleida, perfect for your next Fruitopia ad, as well as the excellent Page Turn. Page Turn enables you to render only the front, back or under layer; you can have different video in each layer by applying the effect over three layers simultaneously. Plus, you get a highlight on the fold. Also in the set is Scatterize, similar to After Effects’s Scatter but with a pseudo-3D warp, and Splatter Paint, which does just that.

Need wipes? Look under Transition, where you’ll find Image Wipe, which operates based on the luminance of the layer of your choice; Radial Scale Wipe, a distorting sci-fi version of an iris wipe; and Scale Wipe, which streaks the image off the screen.

These sets of effects alone would make a good package, but the real stars of the Final Effects show are the particle effects. Yes, particles. With Final Effect’s particles you can easily animate sparks, explosions, smoke, snow and rain, as well as build unique effects. For example, Ball Action breaks an image down into little 3D balls that you can explode in various interesting ways. Because After Effects is a 2D animation program you can’t build as complex a particle stream as you can in a true 3D program, but I’ve found that Final Effects’s particles cover most situations handily. Their convenience, speed and ease of use can’t be beat; I’m sure they paid back the entire package price ($480) the first time I used them for a job.

Set the World Spinning

Working with Final Effects is easy, too. To give you an idea, I’ll walk you through building a rotating Earth with some type spinning around it. Besides Final Effects, you’ll need Adobe After Effects 2.02 and Adobe Photoshop 3.0. As with cooking, there are a hundred ways to do this, but if you follow me your results will match the illustrations. My apologies to those of you who don’t need exact step-by-step instructions.

First, fire up Photoshop, and open your Scrapbook from the Apple menu. Copy (Command-C) the Earth map picture (Figure 1), and closing the Scrapbook, return to Photoshop. From the File menu, choose New, name the file World.pict and click Okay. Paste (Command-V) the Earth map into your new document, and save it as a PICT file (Figure 2).

Quit Photoshop, and launch After Effects—with Final Effects or the Final Effects demo folder (see the sidebar “Try It Yourself,” next page) in the After Effects folder. Create a new composition called Type Comp. The size should be 512 × 256 pixels, but the length doesn’t matter; I used 100 frames (03:10). Make a new Solid (under the Layer menu), also 512 × 256. Click on the eyedropper tool in the New Solid dialog, and click in the surrounding white area.

Choose Text>Basic Text from the Effect menu. In the Text dialog, type the phrase that will orbit the Earth. Set the text to Centered, and click OK. If you can’t see the Effect floater, try Floaters>Effect Controls under the Window menu. In the Effect Controls floater, check Invert Text and pull down the Channels popup to Affect Alpha Channel Only. Set the size to mostly fill...
the width of the Composition (Figure 3).

Make another new Composition, this one named Sphere Comp. The size should be 240 × 180 and length the same as the Type Comp. Set your Still Footage Import preference (Edit menu) to Length of Composition. Import World.pict into the Project, and drag it into the center of the Comp until it snaps (sticks to the center). Under the Effect menu go to Perspective>FE Sphere (it may be called Sphere in older versions of the demo). You should have the Earth perfectly wrapped on a sphere, fully shaded.

Let’s animate a rotation. With the World.pict layer in the Comp selected, press E on your keyboard, which will twirl down the effects controls. Click and hold the Rotation Y control until the Interpolation popup appears, and choose Linear. Press Option/Command/Right Arrow to go to the end of your Comp. Click on the value number to the right of Rotation Y, type -1 into the Revolutions box, and click OK. Press Option-Command-Left Arrow to return to the beginning of the Comp.

From the Project window, click-drag the Type Comp into the middle of the Sphere Comp. Apply FE Sphere to it as well. Again, set Linear Interpolation to Rotation Y and go to the end of the Comp, but this time set the end value to +1 revolution. We’re also going to set some of the other controls for a little design pizazz, but we’ll leave their Interpolation set at the default Constant. Set Rotation X and Rotation Z to 15 degrees (the second box, not revolutions), Light Depth to 100, and Ambient to .25. Also set the Render popup to Front.

Still with me? Good. Duplicate (Command-D) the layer from the Edit menu. Click on the duplicate in the Time Layout window, and drag it down below the World.pict layer. Change the Render popup to Back and Ambient to .10. What we’ve got now is pretty impressive (Figure 4): a 3D Earth rotating in space with type counter-rotating around it. What took just a few minutes with After Effects and the Basic Text and FE Sphere filters would have been much more difficult and required much more time in a 3D program.

Let’s take it one step further to try out the particle effects. Make another new Composition called Snow Comp, again 240 × 180 and the same length. Click-drag the Sphere Comp into it, and apply the Particle>FE Snow effect. The default settings are overkill for this size comp, so set Snow Amount to 450 and Flake Size to 1.0. You’ll notice that the snow falls both in front of the Earth and behind it, giving a very realistic effect (Figure 5). Now if UDAC could only figure out how to get the snow to stick!

**Try It Yourself**

You can see for yourself how Final Effects works. You can download a freely distributable demo version of Final Effects from America Online (Keyword Adobe> After Effects> Public Library) or UDAC Multimedia’s World Wide Web site (http://www.threed-max.udac.se/Final-effects). The demo version is fully functional but draws a green X over the frame to prevent piracy.

To contact UDAC Multimedia directly, write to the company at Box 174, S-751 04 Uppsala, Sweden; phone 011-46-18-187777 or 011-46-18-187778; fax 011-46-18-516600; or e-mail finaleffects@cmd.uu.se.
Double Vision

Increase your workspace and preview effectiveness for little or no investment.

by Charlie White

Is your editing workspace cramped? Do your finished video pieces look jumpy or off-color on a television screen? If you answered "yes" to either of these questions, you should consider adding a second monitor to your setup. No, that doesn’t mean you have to spend more money on equipment; any old NTSC monitor—even a TV set—will do.

I’ll show you how to set everything up. I’ll refer to the Radius VideoVision Telecast system I used, but any video-capture card with an NTSC video-out jack will work. I’ll also refer to System 7.x (particularly the Apple Monitor’s control panel) since I work on a Mac, although this setup is also possible on PC. Most of this two-monitor configuration is done through Premiere and your computer’s operating-system software.

Why Indeed

Running Adobe Premiere at 640 × 480 resolution on a single monitor, your screen quickly fills with windows. If you need to see the Information Window to learn vital statistics for a clip, for example, you may find there’s no room for it on your screen. Now you’re wasting time closing windows to free up space. (For more ways to gain valuable screen space and increase its usefulness even on a single monitor, see the sidebar “More Room Per Square Inch”.)

Besides real estate issues, there’s another important reason to use two monitors with Premiere: You need to preview your sequences in a way that simulates what your viewers will see. This is why, if your work is destined for television display, it’s best to use NTSC (or PAL, if you’re working in that format) for your second monitor.

There’s good reason for the emergence of the joke that NTSC stands for Never The Same Color. The color capability and resolution of the computer monitor you’re using is much higher than that of your video’s final destination—NTSC. Reds in particular are subject to great change. Also, a computer monitor displays non-interlaced video while NTSC monitors display interlaced video. That’s why horizontal lines and underlined text may appear to jitter when viewed on an NTSC monitor.

More Room Per Square Inch

If you’re running a resolution of 640 × 480 on your computer monitor and your video card can handle higher resolutions, try upping the size to at least 800 × 600—or, better yet, 1024 × 768. The icons and windows will be smaller but still legible on a 15-inch monitor even at 1024 × 768, and everything is much more compact.

If you must use 640 × 480, with the Construction Window active select the Windows menu and click on Construction Window Options. On the right side of that dialog box, select the next smallest icon. This will immediately give you much-needed elbow room.

Plugged In

Hooking up a second monitor to your system is as simple as joining it to the composite, component or RGB video-out port of your video digitizer with a BNC or RCA cable.

How will your computer know when you’ve added the second display? A great feature of the Macintosh operating system is its ability to automatically sense when two monitors have been plugged in to the computer. When you open the Monitors control panel, you’ll see a second icon beside the original one (Figure 1). The icon for the computer monitor is the one with the tiny menu bar on top. You can designate which will be your startup monitor by pressing the Option key and dragging the smiling Mac icon over it. Press the Identify button, and numbers will appear on each monitor to tell you which one is which.

Select the icon representing your NTSC monitor and click on Options, and you’ll see the available resolutions for interfaced input (Figure 2). Most television sets (and NTSC studio monitors, when viewed in Overscan mode) crop 10–20% of the full frame. Use Overscan mode to see your video as it will appear to your viewers; it will help you determine whether near-edge titles and graphics will be visible on television screens.

Of course, your monitor may overscan more or less than average. If you select Preview Options from the Make menu and click on Show Safe Areas, title- and action-safe guidelines will appear on your Preview screen. For further assurance, use the Title applet in Premiere to place a line near the bottom of the frame. Preview it in Overscan mode and adjust the line repeatedly until it is directly on the bottom of the visible frame in Overscan mode. Then switch to Underscan and see how much of the screen Overscan crops. Whatever the result, bear it in mind when viewing your video in Overscan mode.

Higher-end studio NTSC monitors offer an Underscan/Overscan switch that allows you the choice without software fiddling.
Collapsing and Expanding

Once you have connected an NTSC monitor to your system and made your overscan/underscan decisions, go to the File menu in Premiere. Under Preferences, select QuickTime Screen. A dialog box will appear asking you to drag the window to where you want QuickTime clips to appear. Drag that box into your NTSC monitor and click OK. If, when you drag the QuickTime screen dialog box onto your NTSC display, the previews still show up in the other monitor (this inexplicable occurrence happened to me), you can trick the software simply by dragging the dialog box itself onto the screen from which you'd like to see your previews. (Sometimes, you have to be contrary in order to defeat contrary software!)

Then, again go to File/Preferences and select General. Click on the Open QuickTime Movies Collapsed check box (Figure 3). This will automatically open movies in your NTSC monitor with the controller for that window collapsed, conveniently sitting on your computer monitor. That little controller alone does not take up much space, and it's right there on your computer monitor where you can get to it easily.

Finally, to ensure that your previews are full screen and automatically centered, select Preview Options from under the Make menu, then click on the Center To Screen box (Figure 4). And while you are still in this dialog box, indicate the screen size you would like to use for previewing.

And Another Benefit...

Depending on the particular monitors you use, there may be yet another benefit to using two screens with Premiere. If your computer monitor is small but you have a rather large NTSC monitor, you'll be able to more clearly see even small-frame video on the larger screen. This means you'll be able to process preview frames at a smaller size when rendering transitions, filters and motion. That speeds up effects processing significantly. Of course, if your final output will be full-screen NTSC video, you will need to process those effects at 640 x 480 to see them at full-screen size.

If you are previewing your work at half-screen size (320 x 240), you can avoid recompiling by using the zoom feature in the Radius Studio Player when you print to video. After selecting Print To Video-Vision Studio, select maximum zoom. Then, you can render your sequence at half-screen size and have it play at full screen. This is a trade-off because the frame is doubled and resolution suffers. If that proves to be a problem, this is still a good way to find out how your work will look on a full screen.

More is More

The particular set-up method I've outlined is the favorite of Premiere's creator, Randy Ubillos. “That’s the way I like to use it,” he said. “I take the Preview window and put it on the NTSC screen. Then, when I open clips, they bring up little controllers and the video just keeps going over to the Preview screen. It’s the best way to do it.” In fact, once you have successfully set up the software and hardware using this configuration, you’ll wonder how you ever used Premiere any other way.

Now, you may wonder, if two monitors are good, wouldn’t three be even better? As a matter of fact, yes! Think about all that scrolling you’re always doing back and forth in the Construction Window. Imagine being able to expand the Construction across two windows while viewing clips on a third monitor. Some well-heeled Premiere jockeys swear by this wide-open-spaces configuration.

I could start extolling the virtues of four monitors, but c’mon. Enough’s enough!
I’m trying to create a time-lapse effect. I didn’t film my footage in time lapse, so I’ve got 30 minutes of tape, but want just a 30-second clip. Can Premiere or After Effects help?

**Fields:** You can take the whole 30-minute clip into Premiere and adjust the Alternate Clip Rate, found in the Clip Menu/Frame Hold Options. (This is the result of one of the Goodies that ship along with Premiere Mac 4.0.1.) In this dialog, you can adjust the Time Base of the clip and employ frame-blending techniques to generate smooth interframes for speeds less than the current frame rate.

After Effects also lets you change the duration of a given video source easily, and it can create interframes using similar frame-blending interpolation.

**Sync:** With Adobe Premiere’s Stop Motion feature, you can digitize a clip at whatever interval you choose. You can then stretch or shrink the clip to a precise length using the Rate Stretch tool in the Construction window. The Rate Stretch tool is a Goodie plug-in in Mac Premiere 4.0, and is built into the Windows version.

I am using Adobe Photoshop to create some files for my Adobe After Effects composition. But working with large files such as filmstrips is slow going—plus I have to guess at the parameters and then verify them when I go back into After Effects. Is there any way to set, while in Photoshop, guides or markers (perhaps in the alpha channel) that I can then use in AE when I’m looking at my composition? I’m using a PowerMac 8100/80 with 24 mgs of RAM and a 4GB hard drive.

**Fields:** Or you can follow these steps. Import your animation (TARGA, PICT, etc.) into Premiere. The “files” are combined into a single clip in most cases. In Windows, you must select in the import dialog the file type that you want to import for a single clip to be created. Drag the newly imported/created movie into the Construction window. Select the animation clip, then pull down the Clip menu and select Speed. Depending on the frame rate you want, type one of the following numbers into the Speed field:

<table>
<thead>
<tr>
<th>FPS</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>500</td>
</tr>
<tr>
<td>10</td>
<td>1000</td>
</tr>
<tr>
<td>12</td>
<td>1200</td>
</tr>
<tr>
<td>15</td>
<td>1500</td>
</tr>
<tr>
<td>24</td>
<td>2400</td>
</tr>
<tr>
<td>25</td>
<td>2500</td>
</tr>
<tr>
<td>30</td>
<td>3000</td>
</tr>
</tbody>
</table>

Now you can make the movie with your desired frame rate and compression method.

Adobe Premiere takes so long to load on my machine. How can I make it load faster?

**Fields:** Adobe Premiere will load faster if you remove features and plug-ins (filters, transitions, device controls, and export and tool items) that you know you won’t use. For instance, if you are controlling a deck with device control, you’ll probably need only one device-control plug-in; the others can be tossed. Likewise, you can remove filters and transitions that you have no use for in your productions. Keep in mind that you can always replace a plug-in that you’ve removed. Besides reducing startup time, removing plug-ins has another positive effect: Items that you use most often become easier to find.

If you are using a Macintosh, open the folder where Adobe Premiere is installed. Then open the folder called Adobe Premiere Plug-Ins, and you’ll see icons corresponding to these categories:

- **Effects:** Transitions
- **Export:** EDL, movie types
- **Filter:** Image and audio filters
- **Device:** Device control
- **Window:** Special purpose functions
- **Zoom:** Hardware zooming controls for print to video
- **Accelerate:** Shortcuts and goodies
- **3D Fork:** Photoshop plug-ins

To remove a plug-in, simply drag it from the Adobe Premiere Plug-Ins folder to another folder for safe-keeping. The next time you launch Adobe Premiere, it will be out of your way.

If you are using Windows, quit Premiere and run the File Manager. Open the Adobe Premiere directory and look in the Plug-Ins directory. You’ll see filenames with these prefixes or extenstions: .8bf Photoshop-style filters
d- Importer for different file types
ex- Export modules for EDLs etc.
fl- Filters
fx- Transitions
x- Device Control
h- Major components

The plug-in name might be cryptic, but the name that shows up in the list in Adobe Premiere is similar to its actual filename. With the exception of h-, any of the file types are fair game for removal. Using the File Manager, move unused items to another directory. If you guess wrong and remove something you need, simply move it back into the Plug-Ins folder and run Premiere again.

Doctor Sync (Michael Wohl) teaches film production and video editing at the Academy of Art College in San Francisco. Professor Fields (John Foster) lives life of the edge by flying, sailing, scuba diving and testing unreleased versions of Adobe Premiere. If you’d like them to sync your fields, send your questions to our editorial offices (see contact information at right).